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THE VERDICT  

Message from the President 

NALS Code of Ethics and  
Mission Statement . . .  

Members of NALS, Association of Legal Professionals 
are bound by the objectives of this Association and the 
standards of conduct required on the legal profession.  

Every member shall:  

 Encourage respect for the law and the 
administration of Justice;  

 Observe rules governing privileged 
communications and confidential information;  

 Promote and exemplify high standards of 
loyalty, cooperation, and courtesy;  

 Perform all duties of the profession with integrity 
and competence; and  

 Pursue a high order of professional attainment.  

Mission Statement 

We are committed to deliver quality legal service 
through continued education and increased 
professionalism, promote and recognize a high standard 
for members through the certification program, and 
provide networking and personal growth opportunities 
for our members.  
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 Happy Holidays, everyone!   

I hope everyone has started their Christmas shopping and are 

well on your way to a stress-free holiday season.  Please make 

sure you make arrangements to attend our annual NALS – 

Nashville Chapter’s Annual Christmas Party.  You will find the 

information for the party in this edition. 

We held our Past-Presidents’ Birthday Dinner on November 15 

at Baker Donelson and it was a big success and everyone had a 

great time reminiscing with the Past-Presidents.  A big thank you 

goes out to our immediate Past-President, Tina Boone, for all her 

hard work planning this event.   

Our TALS Fall Meeting was held on November 6
th

 in Brentwood 

and it was a very informative and fun meeting.  The Winter 

Meeting in February has been cancelled, so our next meeting will 

be the Annual Meeting in Memphis in April 2011.   

Finally, we still have pecans for sale!  If you are interested in 

getting your hands on several bags, please get in touch with 

Delone Anderson or Donice Alford before their GONE for the 

season.  Remember, they’re GREAT for baking, snacking, and 

even gift-giving…and don’t forget they also FREEZE! 

I will leave you with a quote from Dale Carnegie, which may 

help soothe some of your overworked minds during this holiday 

season.  God bless and have a very Merry Christmas and a Happy 

New Year! 

“Do you remember the things you were worrying about a year 

ago? Didn't you waste a lot of fruitless energy on account of most 

of them? Didn't most of them turn out all right after all? Do you 

remember the things you were worrying about a year ago? Didn't 

you waste a lot of fruitless energy on account of most of them? 

Didn't most of them turn out all right after all? ” 

- Dale Carnegie 

Vickie Hellmer, PLS 

 
If you want to build a ship, don't drum up people together to collect 

wood and don't assign them tasks and work, but rather teach them 

to long for the sea. 

- Antoine de Saint-Exupery 
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 NALS – Association of Legal Professionals,  
Nashville Chapter 

 

2010-2011 Officers 
 
President: 
Vickie Hellmer, PLS  
Lewis, King, Krieg & Waldrop, P.C. 
Post Office Box 198615 
Nashville, TN 37219 
Phone (615) 259-1354 
Fax: (615) 259-1389 
vhellmer@lewisking.com 

 

Parliamentarian: 
Delone Anderson, PLS 
Robinson & Robinson 
2nd Floor, Court Square Building 
300 James Robinson Parkway 
Nashville, TN  37201 
Phone:  (615) 259-2802 
Fax:  (615) 259-2804 
Delone011@bellsouth.net 
 

President-Elect: 
Donice Alford, PP, PLS 
Howard Tate Sowell Wilson Leathers & Johnson 
150 2nd Avenue North, Ste. 201 
Nashville, TN  37201 
Phone:  (615) 256-1125 
deapls@yahoo.com  

 

Education Director: 
Nanette M. Green, PLS 
Mitch Grissim & Associates 
325 Union Street 
Nashville, TN 37201 
Phone: (615) 255-9999  
Email: nanette@tnlaw.com  

 
Co-Chair: 
Donice Alford, PP, PLS 
Howard Tate Sowell Wilson Leathers & Johnson 
150 2nd Avenue North, Ste. 201 
Nashville, TN  37201 
Phone:  (615) 256-1125 
deapls@yahoo.com  

 
Secretary: 
Karen S. Mattingly 
Bone McAllester Norton PLLC 
Nashville City Center 
511 Union Street, Suite 1600 
Nashville, Tennessee 37219 
615.687.5789 (Direct Phone) 
615.687.6995 (Direct Fax) 
kmattingly@bonelaw.com 
 

Certification Director: 
Tonya Bowman 
Craft & Sheppard, P.L.C. 
1604 Westgate Circle, Suite 1 
Brentwood, TN   37027 
Phone: (615) 309-1707 
Fax:  (615) 309-1717 
tonyabowman@CraftSheppardlaw.com 
 

Treasurer: 
Tiffany RaShaun Burford  
Waller Lansden Dortch & Davis, LLP  
511 Union Street, Suite 2700  
Nashville, TN  37219  
Phone: (615) 850-8883  
Fax: (615) 244-6804  
tiffany.burford@wallerlaw.com  
 
 
 
 
 

Membership Director: 
Tonya Bowman 
Craft & Sheppard, P.L.C. 
1604 Westgate Circle, Suite 1 
Brentwood, TN   37027 
Phone: (615) 309-1707 
Fax: (615) 309-1717 
tonyabowman@CraftSheppardlaw.com 
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Governor: 
Linda Hulsey 
Burr & Forman LLP 
700 Two American Center 
3102 West End Avenue 
Nashville, Tennessee 37203  
Direct: (615) 724-3224 
Main: (615) 724-3200 
Fax: (615) 724-3324 
lhulsey@burr.com 

 

Marketing Director: 
Rebecca Glenn 
Lewis, King, Krieg & Waldrop, P.C. 
Post Office Box 198615 
Nashville, TN 37219 
Phone (615) 259-1362 
Fax: (615) 259-1389 
rglenn@lewisking.com 
 

Past President: 
Tina L. Boone, PLS 
Waller Lansden Dortch & Davis, LLP  
511 Union Street, Suite 2700 
Nashville, TN 37219 
Phone: (615) 850-8166 
Fax:      (615) 244-6804 
tina.boone@wallerlaw.com 
 

 

 
NALS – Association of Legal Professionals,  

Nashville Chapter  
 

2010-2011 Committee Chairpersons 
 
Audit ...........................................  ABS Financial Services Dan Robinson, CPA 
Award of Excellence ...................  Donice Alford, PP, PLS deapls@yahoo.com 
Bosses Luncheon .......................  Board of Directors Board of Directors 
Charitable Services ....................  Melanie Oyharcabal moyharcabal@lewisking.com 
Court Observance ......................  Betsy DeShano and 

Stephanie Faulkner, CCR, CRI, 
CPE 
 

antbetsy3@aol.com 
stephaniefaulkner@alphareporting.com 
 

Employment  ..............................  Tammy Morris  tmorris@gsrm.com 
History Book ...............................  Betsy DeShano antbetsy3@aol.com 
Journalist ....................................  Vickie Hellmer, PLS vhellmer@lewisking.com 
Nominating Committee ...............  Jerrie Chilcote  jchilcote@sherrardroe.com 
Past Presidents ..........................  Tina L. Boone, PLS tina.boone@wallerlaw.com 
Scholarship.................................  Amelia Workman, PLS amelia.workman@wallerlaw.com 
Sunshine ....................................  Ginger Reeves greeves@nealharwell.com 
Technology .................................  Donice Alford 

Tiffany Burford 
deapls@yahoo.com 
tiffany.burford@wallerlaw.com 

Ways & Means ...........................  NALS Board Members  
Reservations ..............................  Nanette Green and 

Donice Alford 
nanette@tnlaw.com 

deapls@yahoo.com 
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 Employment Committee 
 
Please remember to ask your office administrator to contact Tammy Morris (tmorris@gsrm.com) 
at Gullett, Sanford, Robinson & Martin if there is an employment opening at your firm.  When 
opportunities are available, Tammy will send out an email notifying the membership of possible 
openings.  Also, potential openings will be listed in The Verdict. 

 

Sunshine Committee 
 
The NALS Sunshine Committee is responsible for sending cards, flowers, etc. to any member in 
a time of need.   If you know of a member within the Nashville Chapter that is ill, gave birth or 

has experienced a loss, please email or call Ginger Reeves at greeves@nealharwell.com or 

(615) 244-1713 - Ext. 1163 to let her know so that the Nashville Chapter can send a card.  
 

Certification 
 
Please contact Tonya Bowman for more information regarding out certification exams for ALS, 
PLS, and PP at Tonya Bowman, Craft & Sheppard, P.L.C., 1604 Westgate Circle, Suite 1, 
Brentwood, TN 37027, Phone: (615) 309-1707, Fax: (615) 309-1717, 

tonyabowman@CraftSheppardlaw.com.   
 

Bulletin Board 
 
NALS offers this service to anyone that has items to sell or trade, looking to buy, and/or have 
any other services to offer.  The Bulletin Board e-mail is sent out on a request ONLY basis by 
the person requesting that they be included in the mailing.   If you wish to be included in the 
NALS Bulletin Board periodic listings and/or have anything you would like to list, please contact 
Vickie Hellmer, PLS, at vhellmer@lewisking.com.   
 

December Board Meeting 
 
The monthly Board Meeting will be held on Monday, December 6, 2010, at noon at the law 
offices of Mitch Grissim & Associates, 325 Union Street, Nashville, TN. All members are 
welcome and encouraged to attend. 
. 

December Member’s Meeting 
 
Our Annual Christmas Party will be held in place of December’s Member’s Meeting on Monday, 
December 20, 2010, at the offices of Lewis King, 424 Church Street, Suite 2500, Nashville, TN, 
from 6:00 p.m. – 8:00 p.m.  Please see announcement in this edition for more information.   
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NALS, Association of Legal Professionals, Nashville Chapter  
Monthly Lunch & Learn 

 
  Presents: David Smith, Juvenile Court Clerk 

“Renovating and Rejuvenating the Juvenile Court System” 
 
Date:  December 8, 2010 

  Registration Deadline:  Monday, December 6, 2010 @ 4 p.m. 

  
Place:  Tennessee Bar Association  
  221 Fourth Avenue North, Suite 400 

 
Time:  12 Noon to 1 P.M. 

 
Speaker: David Smith, Juvenile Court Clerk 
 
Topic: ―Renovating and Rejuvenating the Juvenile Court System‖ 
 
Lunch: (1) California Veggie Delight – avocado, lettuce, tomato, cucumber, 

 alfalfa sprouts, provolone cheese, on fresh pita bread *  
 

                        (2)    Salad Sampler 
 

                        (3)    Choice of Ham & Cheese or Turkey Sandwich * 

  

 Option 1 and 3 come with pasta salad and fruit salad. 

 All options come with dessert 
 

*PLEASE ADVISE OF ANY DIETARY ISSUES / SPECIAL REQUESTS.* 
Lunch provided by Deli Dave’s 

  
*Registration fees include the seminar and lunch and  

are payable whether or not the person(s) reserving are in attendance. * 

RSVP NO LATER THAN MONDAY, DECEMBER 6, 2010 @ 4 P.M. 

By phone or e-mail to: 

Donice Alford, PP, PLS 
Howard Tate Sowell Wilson Leathers & Johnson 

Phone:  615-256-1125 
e-mail: deapls@yahoo.com 

 
Please make checks payable to NALS. 

NO OUTSIDE FOOD ALLOWED.
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 REGISTRATION FORM 

 
(Please be sure to specify member or non-member) 

 

Attendee’s Name 

Affiliation (i.e., 
firm, court or other 

business’ name 
Member 
of NALS 

Non-
Member 
of NALS Lunch Choice 

                    
                    
                    
                    
                    
                    
                    
                    
                    
                    
                    
                    
                    
                    
                    

 
NALS Members at $12.00 each: $      
Non-NALS Members at $14.00 each: $      
Total Remitted: $      

 

  



DAVID SMITH 

JUVENILE COURT CLERK 

 

 

David was born in Nashville and raised up in the Madison area.  
He attended Madison High School and Austin Peay State 
University.  He returned home to help with the management of a 
successful family business before starting his career with Metro 
Government.  In 1990 he started with the office of then Mayor 
Bill Boner.  From 1991 – 1995 he worked with the late Judge Jim 
Everett and from 1995 – 1998 with Judge Frank Clement in the 
Davidson County Probate Court.  In 1998 he joined Judge Casey 
Moreland’s staff in the General Sessions Court until he left last December 
to run his campaign for Juvenile Court Clerk. 
 
David also is a licensed real estate agent and Past Potentate of Al Menah 
Shriners of Middle Tennessee. 
 
David and his wife Julianne (who works for Judge Mark Fishburn) live in 
Goodlettsville.  He has two sons, Dustin and Matthew, and two 
grandchildren. 
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NALS 2010 Past Presidents Event 
Monday, November 15, 2010 

 
What an AWESOME Past Presidents event we had on November 15.  Not only because we had two amazing 
past presidents in our presence that were 89 and 87, but, because we had a great number of past presidents that 
came together and just enjoyed each other and talked about past years.  I would be remiss if I didn’t tell you that I 
was personally energized when I telephoned Mary Cooper to ask her to come to the Past Presidents event and 
we just talked and talked and talked.  Who knew that it was amazing in and of itself that I even reached Mary.  
This was definitely meant to be.  We were able to look at a slideshow and reminisce at pictures and stories from 
over the years.   I was honored to be the immediate past president this year and my personal gift to each one in 
attendance was a picture of the evening and a frame.  What a great way to remember the evening!!  It was a thrill 
ladies! 

Standing:  Tiffany Burford, Karen Barnes, PLS (1988), Betty Magee (1989), Cathy Barton (1991), Melanie Collins (TALS-

1987),  Brenda Wolfgang (2005), Vernice Nance Syers, PLS (2007), Donice Alford, PP, PLS (2008), Linda Hulsey 

Seated: Tina Boone, PLS (2009), Ernestine Smith (1955), Mary Cooper (1970), Delone Anderson, PLS (1974), Theresa 

Burnson, PLS (1986), Denise Laumeyer (1987) 



 NALS – ASSOCIATION OF LEGAL PROFESSIONALS 
NASHVILLE CHAPTER 

 
MINUTES OF MONTHLY MEMBERSHIP MEETING 

 
November 15, 2010 

 

In lieu of the monthly membership meeting of NALS – Association of Legal 
Professionals, Nashville Chapter (―NALS‖), the Past President’s Event was held at the 
offices of Baker Donelson on November 15, 2010. 

President-Elect Donice Alford, PP, PLS, called the business portion of the event to 
order at 6:42 pm and thanked everyone for coming.    

Minutes: The September minutes were distributed.  President-Elect Alford asked for 
questions regarding said minutes.  There being no questions, a motion to approve the 
minutes was made by Delone Anderson and seconded by Tina Boone, PLS. 

Treasurer’s Report:  Tiffany Burford-Taylor distributed the September and October 
2010 Treasurer’s Reports.  President-Elect Alford asked for questions regarding said 
reports.  There being no questions, a motion was made to accept the Treasurer’s 
Reports, subject to audit, by Tina Boone, PLS and was seconded by Linda Hulsey. 

Announcements: President-Elect Alford mentioned that there were no minutes from 
the October membership meeting, as the annual Bosses’ Day luncheon served as the 
meeting.  She also reminded everyone that the Nashville chapter was still selling 
pecans.   President-Elect Alford announced that David Smith, the newly elected 
Juvenile Court Clerk, will be the guest speaker at the December Lunch & Learn.  
President-Elect Alford also reminded everyone about the NALS, Nashville Chapter’s 
Christmas party, where Santa will make an appearance. 

Having no further business, the meeting was adjourned at 6:50 pm.  The Past 
President’s celebration immediately followed. 

 

 

 
____________________________________ 
Karen Mattingly, Secretary 
Tiffany Burford-Taylor, Acting Secretary 

 
APPROVED: 
 
_________________________________ 
Vickie A. Hellmer, PLS, President 
 

Watch for upcoming details 
at a meeting near you! 

Plan NOW for your holiday 
gift-giving and baking needs! 
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You are cordially invited to attend and enjoy 
NALS, Nashville Chapter’s Annual 

Christmas Celebration! 
Monday, December 20, 2010 
Lewis King Krieg Waldrop 

6:00 p.m. – 8:00 p.m. 
 

Featured Guest: 

Santa will make a personal appearance! 
 

Every attendee will receive a special gift for attending 
 

Bring a “gag gift” to participate in the “Dirty Santa” game! 
Door prizes, games, good times Galore! 

Food, Fun, Festivities 
 

And a GRAND PRIZE for the taking! 
 

Normal ticket prices in effect ($1 for 1; $5 for 6 and $10 for 12) 

 
If you vanpool, or carpool, make arrangements for the evening…you won’t regret it! 

 
Free of Charge; just attend! 

 
RSVP:  deapls@yahoo.com 

 



Charitable Services 
We will be collecting donations for YWCA’s “The Weaver Domestic Violence Shelter.” It is 

90-day program, and the largest domestic shelter in Tennessee with 51 beds for women and 

children.  They also have a transitional housing program that helps women and children 

for up to one year.  They have a 24-7 crisis line for women in need.  They are in desperate 

need for some of the items below.  Most of the items are needed “new and unopened.”  If 

you have any of these items you would like to donate, please hold onto them and we will be 

collecting them in the very near future.  Thank you for your help in this very worthy cause. 

Please contact Melanie Oyharcabal, NALS Charitable Services Director, at 

moyharcabal@lewisking.com for more information, or to schedule a pick-up of items. 

 

URGENT NEED! The YWCA Domestic 

Violence Center is critically low on the 

following items for residents: 

Flash Lights 

Allergy/Cold/Flu Medicine 

Cleaning Supplies (sponges, furniture polish, 

bug-spray, all purpose cleaners, and glass 

cleaner) 

Coffee and Sweetener/Creamer 

Coffee Filters 

Pillowcases (new or used, but if used – must be 

cleaned) 

Sunscreen 

 

WOMEN’S ITEMS 
Bras (NEW) 

Makeup - Mascara, Eye Liner (NEW) 

Women's Socks (NEW) 

Hair care products for women of color 

Hairbrushes (NEW) 

Hair Conditioner 

Hair Spray/Gel/Mousse 

Razors & Shaving Cream  

Facial Care Products 

Perfume Samples 

Hair Dryers/Curling Irons/Flat Irons 

Anti-Fungal Foot Cream 

Tampons, Pads, Panty Liners 

Gift Items/Sets (NEW) 

 

Needed for Transitional Housing Program:  
Pots, Pans, Skillets, Baking Dishes 

Dinnerware 

Flatware 

Cups, Glasses, Mugs 

Microwaves 

Vacuum Cleaner 

Toasters, Blenders, Coffee Pots 

Can Openers, Cheese Graters, Peelers 

Measuring Cups/Spoons 

Serving/Mixing Spoons 

Brooms, Mops, Vacuum Cleaners 

Televisions, DVD Players 

Towel Sets 

Twin and DBL Sheet Sets 

Furniture, Mattresses (please call ahead) 

Lawnmower (please call ahead) 

 

 

CHILDREN’S ITEMS 

Baby Wipes 

Diapers Sizes 4 - 6 

Booster Seats 

Umbrella Strollers 

Double or Triple Strollers 

Girls' Hair Accessories 

Sports Equipment (NEW) 

DVDs (G or PG rating) 

Non Violent XBox Games 
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Page 12 

 

Page 12 

The Verdict 

 

 

 

 

Happy Birthday ! 
 

 
 
 
 

Have a Fantastic Day ! 

 

Happy Birthday ! 
 

 

Donice Alford  December 4 

Vickie Hellmer  December 7 

Sue Smith  December 7 

Sarah Gwaltney  December 10 

Tara Gess  December 12 

Katrina Hunley  December 31 



  
50 Indispensable Microsoft Word Tips  

Version 2 

No matter how long you've been using Microsoft Word, you can always learn new techniques to 

help you work faster and smarter. Here are some of our favorite tips and tricks for Word  

97/2000/2002(Office XP)/2003, organized into three sections: 

• The Basics 

• Advanced tips, and 

• Things you don't have to do 

 

I. The Basics 

 

1.  Learn to use Undo - Make a mistake? Press [Ctrl]Z or choose Undo from the Edit menu 

right away. Keep pressing [Ctrl]Z to backtrack through and undo the most recent editing changes 

you've made. 

 

2.  Save often - Press [Ctrl]S or click the Save button on the Standard toolbar. Save your 

work frequently. You can also instruct Word to automatically save your work periodically. Open 

the Tools menu, select Options, click the Save tab, and activate the Save AutoRecovery Info 

Every option. You can specify an interval from 1 to 120 minutes. 

 

3.  Quickly move around in a document - To move to the top of a document, press 

[Ctrl][Home]. To move to the bottom of a document, press [Ctrl][End]. To go to the top of the 

next page, press [Ctrl][Page Down]. For the top of the preceding page, press [Ctrl][Page Up]. 

 

4.  Open menus and select commands from the keyboard - Press [Alt] plus the letter that is 

underlined to open a menu, such as File, Edit, View, and so on. Once a menu is open, you don't 

need to press [Alt] to select a command; just press the underlined letter of the command you 

want to select. Here are some common examples: Quick Print Preview: [Alt]F11. Quick Save 

As: [ALT]F7. Quickly reopen the first document in the most recently used file list: [Alt]F1. 

 

5.  Fours ways to select a block of text - Use the mouse. Just click and drag the mouse to 

select text. Use [Shift] plus the arrow keys. Hold down [Shift] and press an arrow key to select 

text in the desired direction. To select a word at a time, press [Ctrl][Shift] and the left or right 

arrow key. Use the mouse with the [Shift] key. Move the mouse pointer away from the insertion 

point position, hold down [Shift] and click to select all the text between the insertion point and 

the place where you clicked. Frustrated when you try to select text with the mouse past the 

bottom of the currently visible page and Word leaps past what you want to select? Those are the 

times to use [Shift] plus the down arrow key instead of the mouse. 

 

6.  Select a word - Double-click on it. If a space immediately follows the word you select, 

the space gets selected, too. Punctuation is ignored. 

 

7.  Select a sentence - Select a sentence. Hold down [Ctrl] and click anywhere in the 

sentence. 
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 8.  Select a paragraph - Triple-click within the paragraph or move the mouse just past the left 

margin of the paragraph. When the pointer changes to a right-pointing arrow, double-click to 

select the whole paragraph. 

9.  Select a table - Select a table by holding down [ALT] and double-clicking anywhere in 

the table.  

 

10. Select cells in large tables using the keyboard (Word 2002/2003) - As the size of a table 

increases, the harder it becomes to use the mouse as your sole means of navigation in a table. For 

example, to select a column with the mouse, you need to move the pointer along the top gridline 

of the first cell in the column until it changes to a down arrow and then click. However, using the 

keyboard simplifies this process. Position the pointer anywhere in the column, press [ALT], and 

select any cell. To use the keyboard to select an entire table, click anywhere in the table and, 

with Num Lock off, press [Altj5 on the numeric keyboard. Like Excel, Word XP and Word 2003 

also let you press [CTRL] to select nonadjacent cells. For example, to select columns 1 and 3 

using the keyboard, press [ALT], click somewhere in column 1, press [CTRL ALT], and click 

somewhere in column 3. 

 

11. Select all the text between the insertion point and •.. - To select all the text between the 

insertion point and the end of the current line, press [Shift][End]. To select the text from the 

insertion point through the end of the current paragraph, press [Ctrl][Shift] and the down arrow. 

To select the text from the insertion point to the end of the document, press [Ctrl][Shift][End]. 

 

12. Select multiple, non-contiguous words (Word 200212003 only) - Select a word, then hold 

[Ctrl] and double-click an additional word or words. This will select the words regardless of 

whether they are adjacent to each other. 

 

13. Select an entire document - Press [Ctrl]A. This is handy when you need to change the font or 

add or remove formatting. Once you've selected the entire document, apply the formatting to 

everything and either leave it applied or apply it again to remove it. For example, suppose some 

text in your document is underlined and you want nothing underlined. To avoid spending time 

visiting each underlined section of text and un-underlining it, select the whole document with 

[Ctrl]A. Press [CtrijU to apply underlining to the entire document and then press [CtrljU again to 

remove the underlining. Be careful when you use [Ctrl]A. If you accidentally press [Delete] or 

type a keystroke and erase everything, don't panic. Just press [Ctrl]Z or choose Undo from the 

Edit menu. 

 

14; Find multiple instances at once (Word 200212003 only) - You can use the Find command to 

count and highlight the occurrences of a particular word. Open the Find dialog box by pressing 

[Ctrl] F or going to Edit I Find. Type the word or words you want to locate in the Find What text 

box. Select the Highlight All Items Found In: check box. Press [Enter] or click the Find All 

button and Word will display the number of instances of that word occurring in your document. 

It will also select them so that they're easy to spot and edit. 

 

15. Grow font, shrink font - Here are three quick ways to change the size of selected text: Choose 

Font from the Format menu and specify the desired point size. Click the Font Size button on the 

Formatting toolbar and select an entry from the drop-down list. Or use the Grow Font and Shrink 

Font shortcuts, which are [Ctrl] plus the close- and open- square bracket characters, respectively. 



16. Rename an existing document - Use Save As. When you need to use an existing document as 

the basis for a new one, don't overwrite the old document. As soon as you open it, press [Alt]F 

and then press A. (Or open the File menu and choose Save As.) Then immediately type a new 

name or change some part of the old one. 

 

17. Print envelopes - Want to address your envelopes in the printer? Type an address in a blank 

document or in a letter. Open the Tools menu and select Envelopes And Labels. (Word XP users 

choose Letters And Mailings and then select Envelopes And Labels.) In the Envelopes tab, enter 

the return address if you want one, and click Print. 

 

18. Expand your vocabulary - Word has a built-in thesaurus. Press [Shift][F7J or open the Tools 

menu, select Language, and then choose Thesaurus. Word will display a list of synonyms for the 

word you've selected or the word closest to the insertion point marker. 

 

19. Make friends with the right mouse button - Don't be afraid to right-click on a block of text or 

a table cell. The shortcut menu offers immediate access to some handy formatting options. 

 

20. Paste plain text - When you copy and paste text from a Web page or another document, the 

text brings its formatting into your document. To get around that behavior, copy the text and 

place the insertion point marker where you want to' insert the copy. Then, open the Edit menu, 

choose Paste Special, and select the Unformatted Text option. 

 

21. Print multiple pages of a Word document on one sheet (Word 2000/2002/2003) -If you 

regularly print large documents or send printed copies of them through the mail, you can save on 

both paper and postage by using Microsoft Word's Zoom feature. With Zoom, you can print as 

many as 16 pages on a single sheet of paper. To print four pages to a sheet, do to File I Print, in 

the Zoom section, select 4 Pages from the Pages Per Sheet drop-down list, make any other print 

selections, and click OK. Zoom automatically reduces the scale to fit four pages on each sheet. 

Zoom reduces the size of your printout without changing the documents format or page layout 

settings. 

 

II. Advanced tips 

 

1. Instant AutoCorrect - Right-Click on a word that's flagged as misspelled to display the Edit 

shortcut menu.  If Word has a suggested alternative, AutoCorrect will appear on the menu. 

Choose AutoCorrect and then select the correct version of the word from the submenu to create 

an AutoCorrect entry. 

 

2.  Effortless AutoText - Save time by inserting AutoText automatically. Type an entry name and 

press [F3]. Or take advantage of Word's AutoComplete feature. Just open the Tools menu, select 

AutoCorrect, click the AutoText tab, and turn on the Show AutoComplete Tip For AutoText And 

Dates option. With this feature active, Word will show a Screen Tip after you begin typing an 

AutoText item. Just press [Enter] and Word will insert the item for you. (This feature works the 

same way with dates and days of the week.) 

 

3, Marker display - Work with paragraph markers and tab marks displayed. Simply click the 

Show/Hide 11 button on the Standard toolbar. Displaying those normally hidden characters helps 
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 you avoid inadvertently deleting objects or changing formatting; it also helps you figure out 

funky alignment and extra white space problems. 

 

4. Use AutoCorrect as a text expander - You don't have to keep typing those long words or 

phrases you have trouble with. Come up with a three- or four-letter abbreviation for it and add it 

to AutoCorrect. For example, say you often need to type Indianapolis. Press [Alt]T (to open the 

Tools menu) and press A to select AutoCorrect. Type indy, press [Tab], type Indianapolis, and 

press [Enter] twice. Now, any time you type Indy followed by a space or any punctuation, Word 

will automatically "correct that spelling and replace it with Indianapolis. You can save up to 255 

characters in an AutoCorrect entry. (If you need more characters or you want to include pictures 

along with text, use AutoText instead.) 

 

5. Clear a table - If you need to delete the contents of all the cells in a table, just select the table 

and press [Delete] (not [Backspace]). 

 

6, Display built-in styles - When you create a document, Word starts you out with a handful of 

basic styles. If you need to apply a more specialized style, hold down [Shift] and click on the 

arrow beside the Style box on the Formatting toolbar. Word will expand the Style list to include 

all its built-in styles. Just select the one you need and Word will apply that style and add it to 

your document. 

 

7, Quick table column total- Performing addition in a Word table is simple. Click in an empty 

cell at the bottom of a column of numbers. Open the Table men~, select Formula, and press 

[Enter] to accept the default Sum function. 

 

8. Styles as you go - Define styles on the fly: Format a paragraph the way you want. type a name 

in the Style box on the Formatting toolbar. and press [Enter). 

 

9. Quick field toggle - Press [Alt][F9) to quickly toggle field code display on and off. 

 

10. Add a border to a page - To add a border to page. open the Format menu. select the Borders 

And Shading command, and click the Page Border tab. 

 

11. Faster Go To - Double-click the left end of the status bar to bring up the Go To tab so you 

can jump to an item in your document such as bookmark, a specific page, a table, a section, and 

so on. 

 

12. Splitsville - See two parts of a document at the same time by choosing Split from the 

Window menu and clicking to place the split bar where you want to divide the document 

window. Separate vertical scroll bars allow you to bring different portions of text into view-and 

you can set different view preferences for each pane (such as normal view in the top pane and 

outline view in the bottom). To restore the panes to a single·window, just double-click the split 

bar or drag it beyond the top or bottom of the window. 

 

13. Selective word count - Need to know how many words, characters, paragraphs, or lines 

appear in a portion of a document? Just select the text you want to run the count on prior to 

choosing Word Count from the Tools menu. 

 



14. Trim ragged text by turning on hyphenation - When text contains many long words and your 

left and right margins are close to one another, your right margin can look ragged. To help 

smooth out that edge, choose language from the Tools menu, select Hyphenation, click in the 

Automatically Hyphenate Document check box, and click OK. 

 

15. Copy formatting to more than one block of text - To copy the formatting from the current 

word or paragraph, click the Format Painter button on the Standard toolbar and then select the 

word or block of text to which you want to apply that formatting. To copy the same formatting to 

more than one block of text, double-click on the Format Painter button. Then you can apply the 

formatting to several blocks of text. To turn off the Format Painter, just click the button again or 

press [Esc). 

 

16. Jump quickly between documents -If you work with a lot of open, overlapping documents, 

here's a quick way to cycle between them: Press [Ctrl][F6) to jump from one to the next; 

[Ctrl][Shift][F6) will jump you backward. 

 

17. Insert and format symbols - For instant access to thousands of special symbols, like foreign 

characters and wild and crazy icons, open the Insert menu, choose Symbol, and look through the 

selections available with different fonts and subsets of fonts. After you insert a special character 

or symbol, you can then select it and use [Grow Font) and [Shrink Font) on it. 

 

18. Create a desktop shortcut to a document - To create a document shortcut, first highlight some 

text to serve as a target in the document and click the Copy button. Next, minimize the Word 

window or drag it out of the way so you can see the Windows desktop. Then, hold down [Ctrl), 

right-click on the. desktop, and  choose Paste Shortcut. You'll probably want to change the 

shortcut name to something more meaningful. To do this, click on the shortcut to select it and 

then press [F2) to activate the label for editing, Type the desired name and press [Enter). Close 

your document, clicking Yes to save your changes. You can even exit Word, if you want. Then, 

Simply double-click on the desktop shortcut. Word will open the associated document, navigate 

to your target text, and select it. 

 

19. Insert frequently used text with a macro - Macros are extremely handy for performing multi-

step operations, including simple text entry. If you routinely use a word, phrase, or entire 

paragraph, you can create a macro that will automatically insert the text. To start recording your 

macro click Tools I Macro I Record New Macro. You will be prompted to enter a name for your 

new macro, specify the document template in which the macro will be stored, and enter a short 

description. Click OK when you're ready to begin recording your new macro. Word will record 

every mouse click and keystroke you make until you click the Stop Recording button. Type in 

your text and click Stop recording. To use your new macro, click Tools I Macros, select you 

macro from the list of available macros, and click Run. To make the process even easier, you can 

tie the macro to a keyboard shortcut. Click Tools I Customize and click the Keyboard button. 

Under the Categories list, scroll down and select Macros. A list of available macros will appear. 

Select the desired macro and click into the Press new shortcut key field. Press the key to which 

you want your macro assigned and then click the Assign button. Return to the document by 

clicking Close button twice and your new keyboard shortcut is ready to use. 

 

III, Things you don't have to do 
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 1. Worry - You don't have to worry about doing something wrong. Just get familiar with the 

program and experiment with Word features. If something looks wrong or funny, that's when 

you use the Undo feature. Press or type the wrong thing, try [Ctrl]Z to undo whatever you did. 

Always remember you can press [Ctrl]Z or choose Undo from the Edit menu to undo changes 

one at a time. Aside from deleting or failing to save a file, there's almost nothing you can do that 

isn't reversible. 

 

2. Move your hands from the keyboard - You don't have to use the mouse to do things like open 

menus, select or format text, or move the insertion point marker. You may find you work more 

efficiently if you're not always moving your hand from the keyboard to the mouse. Press [Home] 

to move to the beginning of the current line and press [End] to move to the end of the current 

line. Press [Ctrl] and the left or right arrow to move one word in either direction. Hold down 

[Shift]J while pressing those keys to select the text between the insertion point marker and the 

beginning or the end of the line, respectively. 

 

3. Select an entire paragraph to change formatting or style - You don't have to select the entire 

paragraph to change the paragraph's formatting or style. Just click anywhere in the paragraph and 

choose the desired format or style. A good example is justification. Just click anywhere in the 

paragraph and then click the Align Left, Align Right, or Justify button on the Standard toolbar. 

 

4. Work with only one document at a time - You don't have to close one Word document before 

you open another. Open as many at a time as you want to. Use the [Ctrl][F6] keyboard shortcut 

or the Windows menu to move quickly between open documents. 

 

5. Risk missing something you're looking for - You don't have to visually scan and manually 

scroll through a document looking for a word or phrase. Use [Ctrl]F to open the Find tab and let 

Word locate the text for you. 

 

6. Waste time during spelling Check - You don't have to repeatedly click Ignore or Ignore All 

every time the spell-checker stops on a proper noun or a term that's commonly used in your 

documents. Click Add (Add To Dictionary in Word XP) so you don't waste time checking the 

same words over and over. 

 

7. Delete old text you're replacing - You don't have to delete text you want to replace with new 

text. Select the old text and start typing the new. The first keystroke replaces the old selected 

text. Don't waste time pressing [Delete] first. 

 

8. Press [Backspace] over and over- You don't have to press [Backspace] a dozen times to delete 

a word or phrase. If you type something and then change your mind, pressing [Ctrl][Backspace] 

to delete a word at a time is much faster. Only one thing is more wasteful: using the mouse to 

click on the beginning of a word or phrase and then pressing [Delete] repeatedly. (You can use 

[Ctrl][Delete] to quickly remove words in that situation.) If you get overzealous with 

[Ctrl][Backspace] or [Ctrl][Delete] and remove one word too many, press [Ctrl]Z to bring it right 

back. 

 

9. Use the default toolbar configuration - You don't have to settle for the default toolbar 

configuration that shows the Standard and Formatting toolbars. Click View I Toolbars to reveal a 

list of available toolbars. If you routinely edit documents, the Reviewing toolbar comes in very 



handy. Use the Tables and Borders toolbar to quickly create tables or the Drawing toolbar to 

easily manipulate graphics. You can also edit Word's toolbars by clicking View I Toolbars I 

Customize, which opens the Customize window. With this window open you can rearrange a 

toolbar's buttons, add or remove button, even edit a button's image or create your own special 

toolbars. 

 

10. Count words by hand (Word 2000/200212003) - Don't waste time manually counting words. 

Word's count function will tell you how many words and characters are in a document, 

paragraph, or selection. Word 2002 and 2003 offer a Count toolbar that even simplifies the 

process. Click View I Toolbars I Word Count. 

 

Tell us what you think BNET downloads are designed to help you get your job done as 

painlessly and effectively as possible. Because we're continually looking for ways to improve the 

usefulness of these tools, we need your feedback. Please take a minute to drop us a line and tell 

us how well this download worked for you and offer your suggestions for improvement. 

Thanks! 

- The BNET Team 

Updated by Leslie Leite 

Tips submitted by Jeff Davis, Jody Gilbert, Travis Frazier, Mary Ann Richardson, Vidyaramanan 

5., and Bill Detwiler 

Copyright ©2007 CNET Networks, Inc. All rights reserved. 

For a free BNET membership, please visit www.bnet.com 

50 Indispensable Microsoft Word Tips 
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EMPLOYMENT OPPORTUNITIES 

 
Sherrard & Roe is looking for an "Office Assistant" for their firm. This is an entry level 

position which includes duties of filing, scanning, and records management. This person 

will be trained in their system and will assist the legal secretaries as well. Currently, they 

are looking at 25-30 per week part time. Please email your resumes to 

lblackwood@sherrardroe.com Thanks. 
Leah Blackwood | Administrative Assistant| Sherrard & Roe, PLC 

424 Church Street | Suite 2000 | Nashville, TN 37219 | w: 615.742.4593 | f: 615.742.4539 

 
Sherrard & Roe has made some internal changes and instead of a litigation legal assistant 

(secretary) they are now looking for a Legal Secretary for their estate and tax group.  Prior 

experience in this particular practice area is beneficial, but not mandatory.  Prior legal experience 

is required along with excellent technical skills.  Excellent technical skills are required.  Sherrard 

& Roe offers excellent benefits and a great work environment.  Salary will be commensurate on 

experience.    

  

Qualified applicants should email resumes to ddobson@sherrardroe.com.   

 

 
Donna Dobson 
Legal Administrator 
Sherrard & Roe, PLC 
424 Church Street, Suite 2000 
Nashville, TN 37219 
615-742-4200  
______________________________________________________________ 

Contracts and Pricing Manager 

A local company’s Administration Dept. is seeking qualified candidates for the position of 

Contracts and Pricing Manager.  This position has the overall responsibility for the coordination 

and activities related to the management and administration of contracts, subcontracts and 

contract addenda, including managing a staff of contracting professionals, development and 

implementation of strategies, policies, and guidelines in connection with all phases of 

procurement and administration related to company initiatives, and the negotiation and execution 

of agreements, contracts, cooperative agreements, and subcontracts.  This position reports to the 

company’s CFO. 

Primary Duties And Responsibilities: (i) Responsible for facilitating, developing and supervising 

activities related to the development of contract management and cost proposals, contract 

negotiations and subcontract administration; (ii) Responsible for coordinating or assisting 

financial department with cost estimating, cost proposal preparation, contract negotiation, 

subcontracting, purchasing, financial analysis and reporting, contract compliance, project audits, 

and any other contracting and/or pricing business related support required by employer; (iii) 

Responsible for effectively conjoining efforts with the Sales Department and the Vice-President 

mailto:lblackwood@sherrardroe.com
mailto:ddobson@sherrardroe.com
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 of Sales and Marketing to respond in a timely, professional and comprehensive manner to 

project/client directives and requests involving contract compliance, subcontracting, 

procurement, budgeting, cost proposals, project audit, and other contractual and pricing related 

issues; (iv) Develops and maintains effective relationships with customer contracting officials to 

facilitate business transactions and enhance future purchases and acquisitions; (v) Drafting and 

negotiating of software license agreements, professional services agreements, contract addenda 

and reseller and partner agreements; (vi) Reviewing RFPs, RFIs, and RFQs, offering appropriate 

alternatives to contract terms and conditions; (vii) Point of contact for MediNotes; (viii) 

Responsible for price book changes(i.e specifications, format, pricing, etc.); (ix) Responsible for 

all existing ASP client renewal agreements/contracts, post contract processing and questions and 

all acquisition or divestiture amendments/assignments of software; (x) Prepare cost analysis 

projections, letter and language drafting, product/pricing/module research and statistics regarding 

new contracts; (xi) Works with 3rd parties to obtain criteria and pricing; and (xii)All additional 

duties as assigned. 

Other Requirements / Skills (Education, Software, Hardware, Etc.):  (i) BS or BA degree with 5+ 

years of contract management experience; (ii) Minimum 3-5 years experience in a legal or 

paralegal environment; (iii) Minimum 3 years software and services contract 

management/negotiation in a healthcare related environment; (iv) Excellent written, proof 

reading and verbal communication skills; (v) Must be detail-oriented, organized and have the 

ability to multi-task; (vi) Must be flexible with a can-do attitude and have the ability to remain 

professional under high-pressure situations; (vii) Ability to retain and protect confidential 

material; (viii) Strong computer skills in Microsoft Office applications, including Word, Excel, 

PowerPoint and Outlook; (ix) Good interpersonal skills that include the ability to effectively 

communicate in both writing and verbally; (x) Must be detail oriented, organized, work under 

deadlines, and have the ability to multi-task; (xi) Strong computer skills in Microsoft Office 

applications (i.e., Word, Excel, PowerPoint, etc.); (xii) Negative pre-employment drug tests; and 

(xiii) Criminal and MVR backgrounds that meet the company’s hiring criteria. 

Qualified candidates please send resume to Lauralyn Chrisley lchrisley@koernerassociates.com.   

______________________________________________________________ 
 

The Brentwood law firm of Papa & Roberts is seeking a skilled administrative assistant.  The 

position includes greeting clients, answering phones, drafting documents, managing mail, data 

entry, filing court documents, scheduling appointments, and maintaining client files. Candidate 

must be warm, outgoing, professional, reliable, organized, and detail-oriented.  Applicants must 

have a high school diploma or equivalent, along with excellent computer skills. Prior law office 

experience, knowledge of Abacus software, and Bachelor’s degree are preferred.  Hours are 8am 

to 5pm Monday-Friday.  Compensation includes paid time off.  Starting pay is $10/hour.  

Qualified candidates please send cover letter and resume to Jennifer Kamper at 

jkamper@paparoberts.com. 

_____________________________________________________________ 
Frost Brown Todd has an immediate opening for an experienced paralegal in its bankruptcy 

practice.  This position will be located in their offices at 424 Church Street, in Nashville, Tennessee.  

Requirements for the position include a Paralegal Degree and/or Paralegal Certificate; strong verbal 



and communication skills; proficient computer skills (Word 2007 preferred); flexibility to work 

overtime as needed; good organizational skills; ability to work well under deadlines; and excellent 

interpersonal skills.  This position will assist in preparation of bankruptcy pleadings; involve 

electronically filing bankruptcy pleadings and handling of service.  Other responsibilities will 

include:  Preparation of hearing binders, preparation and filing of Proofs of Claim, utilization of 

bankruptcy software to generate bankruptcy petitions, statements and schedules and creditor 

matrix, maintenance of paper and electronic files, and generally assisting with other bankruptcy 

matters. Experience with bankruptcy practice is preferred.  Familiarity with Best Case, Power 

Point and Excel also helpful.      

 

Frost Brown Todd offers a professional atmosphere and a competitive salary and benefit package.  

Please forward your resume, cover letter and salary requirements to Gwen Adkisson, Office 

Manager, Frost Brown Todd LLC, 424 Church Street, Suite 1600, Nashville, Tennessee 37219-

2308 or by e-mail to gadkisson@fbtlaw.com. 

_____________________________________________________________ 
 
Bankruptcy Paralegal  
 
Special Counsel is currently interviewing paralegals for a permanent Corporate Bankruptcy Paralegal 
position with a law firm.  
 
Candidates must have at least 2 years of corporate bankruptcy experience representing the debtor.  
Paralegal certificate preferred. Must have familiarity with Best Case, PowerPoint, Excel and Word. 
 
Duties include: assist in preparation of bankruptcy pleadings, electronically file bankruptcy pleadings and 
handle service, prepare hearing binders, prepare and file proofs of claim, use bankruptcy software to 
generate bankruptcy petition, statements and schedules and creditor matrix, calculate and track notice, 
objection and hearing dates in bankruptcy cases, assist as needed with electronic evidence at hearings, 
handle other general bankruptcy matters. 
 
Salary – $60,000+ 
 
Qualified candidates please send resume to Audrey.Taylor@specialcounsel.com for immediate 
consideration.  

_____________________________________________________________ 
E-Discovery Searching Strategies: Crafting Keyword Lists 

By Dr. Gavin W. Manes, President and CEO of Avansic 
 
 
Choosing the right keywords during the processing stage of e-discovery means a 
greater chance of finding target documents, thereby reducing review time. Many 
attorneys have had the experience of sending what they thought was a comprehensive 
and specific list to a vendor and receiving thousands of irrelevant documents in 
return.  
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 Here are some tips and tricks for crafting a search term list that can help instead of 
hurt. Knowing a little bit about how computers name files and how automated 
programs “search” for documents can empower attorneys to make effective keyword 
lists. 
 

1) Use “wildcards” to your advantage – A wildcard, commonly represented by a 
“*” symbol, tells the computer “any character or characters can be here.” For 
instance, if you’re looking for singular and plural instances of the word, you 
can search for “dog*” and the computer will return all hits with “dog”, “dogs”, 
“dogged” and “doghouse.” Careful use of the wildcard can allow the 
simultaneous search for multiple tenses, plural words, and sometimes 
misspellings.  

 
2) Short words and single characters are not your friend – Many e-discovery 

products won’t even index words of less than 3 characters and often don’t 
index the most common words such as “the”, “any”, and “because”. Even if 
the short word is indexed, the chance of getting junk results is much higher for 
short words. If you have to search for a very short word or abbreviation, 
consider pairing it with another word that generally appears in the same 
document or ask that the abbreviation be searched for in a case sensitive 
manner. 

 
3) Phrases – The more unique and contextual the search terms, the better the 

results. Combined with the use of wildcards as mentioned above, using phrases 
will give much more specific results than each word searched separately. Most 
e-discovery programs also have a “within” feature, where it can be specified to 
return all instances of a word when it occurs within several words or characters 
of another keyword. For instance, a search for “quick” within two of “fox” 
would return a hit on the phrase “the quick brown fox” but would not return 
“the quick sand”.   

 
 
  



4) Tenses – For words where wildcards may not work on various tenses, fuzzy 
searching can be utilized. Fuzzy searching uses both a dictionary of common 
tenses and misspellings as well as an algorithm to determine words that are 
“near” to the word being sought. For example, a fuzzy search for “receive” 
would find “recieve”. A search for “find” would locate “found.” Fuzzy 
searching can be powerful, but should be used in moderation as it can provide 
false positive results.  

 
5) De-NISTing (or NSRLing) – This process is also known as “known file filtering” 

and compares an e-discovery set against a list of known files kept by the 
National Software Reference Library. It removes common operating system files 
in order to reduce a data set, but should be used thoughtfully since the 
presence of certain known files may be relevant to a case. For example, the 
installation of a remote desktop program might be important if the case 
involves a theft of intellectual property from a terminated employee, but that 
program information might be removed from the set during de-NISTing. 

 
Any expert e-discovery vendor will be happy to consult with you regarding keyword 
lists. Those with significant experience with e-discovery processing tools know the ins 
and outs of those programs and can refine your concepts, phrases, and words in order 
to produce the most relevant data set. In the end, a refined data set will take less 
time and money to review, leading to lower e-discovery and overall litigation costs.  
 
 
About the Author 
Dr. Gavin W. Manes, President and CEO of Avansic, is a nationally recognized expert 
in e-discovery and digital forensics. Dr. Manes has published over fifty papers on 
computer security and digital forensics, and has given hundreds of presentations to 
attorneys, executives, students, professors, law enforcement, schools, and 
professional groups on topics ranging from ESI processing to cyber law. 
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Give2TheTroops'®  
OFFICIAL LIST 

of the Most Popular  
ITEMS REQUESTED BY OUR TROOPS 

 
Please contact your Nearest Branch 

to coordinate donations drives, drop-off dates or other shipping arrangements. LARGE 
shipments or pallets of items need to be scheduled ahead of time & sent only to our 

NORTH CAROLINA or CONNECTICUT BRANCHES. 
 

This list is designed specifically for troops registered with our organization and 
may not be copied or distributed without our permission  

 

Due to our Policies and Regulations, we CANNOT ACCEPT these items:  
 
HOME-BAKED FOOD 
GLASS BOTTLES or GLASS JARS 
AEROSOL CANS or SPRAYS 
EXPIRED FOOD 
CANNED FOOD 
LIGHTERS, MATCHES or LIGHTER FLUID 
HOTEL SAMPLES 
VHS TAPES or CASSETTE TAPES 
CONTRABAND ITEMS (live plants, tobacco, knives, nudity, etc.)  
HARD-COVER BOOKS & MUSIC CDS* (*CDs accepted only at our North Carolina 
Branch) 
 
For security and sanitary reasons, please leave all items in their original packages.  
When purchasing items, please choose the latest expiration date possible.  
 
Thank you for your cooperation and support! 
 
* Items in PURPLE are the MOST NEEDED & REQUESTED * 
 
FOOD (SNACKS) & ENTERTAINMENT ITEMS ARE ALWAYS THE #1 REQUEST 
FOOD, SNACKS AND DRINKS: 

 BEEF JERKY / SLIM JIMS 

 COFFEE (Ground or whole; instant or drip. Ground is preferred)  

 POWDER DRINK MIX (Gatorade, Kool-Aid, Crystal Light)  

 SUNFLOWER SEEDS & PUMPKIN SEEDS  

 TUNA & CHICKEN SALAD (in foil pouches, or ready-to-eat kits (no cans)  

 PROTEIN POWDER & PROTEIN BARS  

 CHOCOLATE PRODUCTS accepted from OCTOBER through April (it will melt 
in high temperatures!) 

 Hot Chocolate packets, Herbal teas  

 Hard Pretzels / Cheetos / Fritos / Chex Mix / Wheat Thins / Ritz 

 Gum / Hard Candy (must be individually wrapped in large bags)  

file:///C:/Documents%20and%20Settings/Donice/Local%20Settings/Temporary%20Internet%20Files/Content.IE5/PSVC6IE2/donations.htm


 Granola Bars / Power Bars / Cereal Bars / Cliff Bars  

 Fig Newtons, Oreos, Cheese & Crackers - Small Packs  

 Trail Mix, Dried Fruit, Granola, Fruit Roll-Ups / Fruit By The Foot / Fruit 
Gummies  

 DRY SOUP: (Ramen Noodles / Cup-O-Soup: just add water) 

 NUTS: Peanuts, Mixed Nuts (salted preferred)  

 MICROWAVE FOOD (Popcorn, Chef-Boy-R-Dee, Mac'n'Cheese...)  

 COOKIES / Girl Scout Cookies (with chocolate: Oct. - Feb. only!)  

 Rice Krispie Treats (Store-bought only) 

 Little Debbies® & Hostess® cake products  

 Oatmeal Packs (Instant: just add water) 

 Cereal (Small, individual boxes) 

 Condiments, Spices; Sugar; Salad Dressing (no glass jars)  

 Caffeinated gum or candy (to stay alert)  
TOILETRIES: NO HOTEL SAMPLES!  
(Note: Some troops have allergies & need Brand Name toiletries which list all 
ingredients. The military issues toiletries to our troops, however troops often miss 
their favorite brand of shampoo or soap. Our goal is to send troops reminders of home 
& items they miss ... not free samples.) 

 BABY WIPES (travel size)  

 HAND SANITIZER (travel size) 

 Body Wash, Liquid Soap, Facial Cleanser 

 Shampoo /Conditioner (travel size)  

 Hair Gel (for female troops to pull hair back)  

 Combs / Brushes / Bobby Pins (in original packaging, please) 

 Deodorant (travel size)  

 Razors (disposable or "Intuition" or "Mach 3" types)  

 Shaving Cream in Tubes / Shaving Soap (No CANS of Shaving Cream, please!)  

 Lip balm / Chap Stick / Carmex / Blistex  

 Baby Powder & Foot Powder (travel size)  

 Tissues (individual packs; travel size only)  

 Hand & Body Lotion / Moisturizer (travel size)  

 Sunblock, SPF 45, Zinc, Vitamin E, Aloe Vera Gel  

 Bug Spray / DEET / Skin-So-Soft  

 Mouthwash (travel size) 

 Toothpaste & Toothbrushes & Dental Floss 

 Breath Mints / Breath Strips 

 Lozenges / Cough Drops  

 Loufa Sponges / Buff Puffs / Washcloths  

 Nail files / Emery Boards / Nail Clippers  

 Feminine Hygiene Products  

 Cotton Swabs (i.e. Q-tips) - also used to clean guns!  

 Cotton Balls  

 Band-aids, Gauze Pads, First Aid Kits / Ace bandages, Icy Hot or Bengay cream 

 Moleskin  

 Shoe Insole Cushions (gel kind is best)  
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  Tylenol, Motrin, Advil or Aspirin Packets  

 Eye Drops (i.e. Visine)  

 Nasal Spray  

 Vitamins (multi-vitamins are always needed!)  
ENTERTAINMENT AND SPORTS: 

 BATTERIES: (AA, AAA, C & 9 Volt are the most requested)  

 DVD Movies (new or used - recent releases only, please!)  

 Xbox Games, PSP, PS2 & PS3 Games (new or used)  

 iTunes® Gift Cards  

 35 mm disposable cameras  

 Computer Flash Drives & Thumb Drives  

 Portable CD players / head phones  

 Electronic handheld games  

 Small homemade gifts - reminders & comforts of "home" 

 Small photographs or posters of scenery for their tents & walls  

 Pens & mechanical pencils, small note pads  

 Stationery & Envelopes; blank cards to send home  

 Double-sided tape, small crafts kits, scrap-booking items  

 Day planners / Calendars / Small, Pocket Calendars  

 Game Books: (Crossword Puzzles / Word Search Books / Math Puzzle books / 
MAD LIBS / Logic Problems / Sudoku)  

 Yo-Yo's, Dominoes, Playing Cards (new), Poker Chips & Mats, Dice  

 Board games (UNO, Othello, Checkers - travel size is great, too!)  

 Dart Boards (regular or magnetic - any size)  

 Nerf Footballs / Whiffle bats, balls & Mitts / Sports equipment  

 Frisbees / Hackey sacks 

 Music CDs, Magazines & Books (Accepted ONLY at our NORTH CAROLINA 
BRANCH)  

OTHER: 

 LINENS: Pillow cases, twin sheets, towels (green & tan)  

 T-SHIRTS: Cotton green & tan under shirts - new (Sizes: M, L & XL)  
[Note: The DOD banned "Under-Armor" shirts due to its material being 
potentially flammable & bad reactions to open wounds.]  

 LAUNDRY DETERGENT & FABRIC SOFTENER SHEETS: (Click HERE for types)  

 FLASHLIGHTS - SMALL (battery operated. Surefire Brand preferred)  

 AIR FRESHENERS (standalone-not plug-in. Car types are also good) 

 SOCKS: Black, Olive Green & White (cotton or wool)  

 PHONE CARDS - Pre-Paid (Click HERE for Where to Buy and What Types of 
Phone Cards to Buy from Third-Party Vendors)  

 Gift Cards to send home to loved ones (for Restaurants, Supermarkets)  

 Small toys (Beanie babies) & school supplies for Iraqi & Afghan children 

 Patriotic knick-knacks, USA flags, flags from your state, bandanas, baseball 
hats, football jerseys, banners to tack on their walls or tents.  

 Black or Green duct tape, small tool kits, dust masks, carpentry tools, Fly 
swatters, fly paper, mosquito netting, bug repellent in plastic pump bottles 
only (NO AEROSOL CANS, PLEASE!)  

file:///C:/Documents%20and%20Settings/Donice/Local%20Settings/Temporary%20Internet%20Files/Content.IE5/PSVC6IE2/laundry.htm
file:///C:/Documents%20and%20Settings/Donice/Local%20Settings/Temporary%20Internet%20Files/Content.IE5/PSVC6IE2/PhoneCardInfo.htm


 Paint brushes, adhesive wall hooks  

 Gun cleaning supplies (lube) such as Militec-1 & CLP  

 Generic sunglasses (Ballistic, black only. No "mirror" types)  

 Alarm Clocks (Small in size; wind-up or battery-operated)  

 Small, portable heaters & fans (110 voltage okay)  

 Fleece Blankets (Yes, it gets very cold in the winter over there!!)  

 Disposable Hand warmers and Foot warmers (in the wintertime)  

 Winter Hats (Yes, it snows in the winter over there! Hand knitted hats in 
black, tan or green are always welcome!)  

 Water Bottles, Travel Mugs & Thermoses with Lids, (for Coffee, Tea & Soup)  

 Coffee Makers & Filters (110 voltage okay)  

 Coffee Bean Grinders - small (electric or battery-operated)  

 Microwave Ovens (55 pounds max; 110 voltage okay)  

 Hot Pots - Small  

 Elixir & Water Purification Tablets for Camelbaks  

 Combat Application Tourniquets (black only)  

 Religious booklets, small bibles, inspirational readings  

 Holiday and Seasonal Decorations - see our PROGRAMS PAGE for details 

 K-9 items:  
Dog treats, toys, shampoo, flea collars, etc.  
(Note: CLICK HERE to see our restrictions and guidelines if you wish to donate 
items to the dogs. Thank you.) 

CARDS & LETTERS: The troops love to hear from all of us and Mail brightens their 
days! These are the MOST IMPORTANT items we can send the troops & we can never 
have too many, so please keep writing! consider making a patriotic banner or poster 
to send inside one of our care packages!  
 
Note: Our troops do not need stamps as they're in war zones & may send mail home to 
their loved ones at no charge, but our branches can always use stamps to send 
correspondence. 
http://give2thetroops.bravejournal.com/http://give2thetroops.bravejournal.com/ 
Visit our Forum to Read & Post Messages! 
 
 

 
 
 
 
 

file:///C:/Documents%20and%20Settings/Donice/Local%20Settings/Temporary%20Internet%20Files/Content.IE5/PSVC6IE2/programs.htm
file:///C:/Documents%20and%20Settings/Donice/Local%20Settings/Temporary%20Internet%20Files/Content.IE5/PSVC6IE2/k9s.htm
http://give2thetroops.bravejournal.com/
http://give2thetroops.bravejournal.com/
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TALS - LEGAL PROFESSIONALS OF TENNESSEE 

2010-2011 SCHEDULE 

Date Purpose Location 

July 31-August 2, 2009 Region 4 Asheville, NC 

August 7, 2010 TALS Summer Meeting Nashville, TN 

October 8-11, 2009 NALS 59th Annual Education 

Conference and National Forum 

Branson, MO 

*September 30. 2010 Deadline for Fall Junction Edition  

November 6, 2010 TALS Seminar/Fall Meeting Rutherford/Cannon/Williamson 

*December 31, 2010 Deadline for Winter Junction Edition  

February ___, 2011 TALS Seminar/Winter Meeting CANCELLED 

*March 31, 2011 Deadline for Spring Junction Edition  

April ___, 2011 TALS Seminar/Annual Meeting Memphis 

 

*DATES SUBJECT TO CHANGE 

 

YEAR 2010 HOLIDAYS CALENDAR 
 

The following are dates to remember for the rest of the year.  
 

December 2010 •  Friday December 17th --Wright Brothers Day 
•  Tuesday December 21st --First Day Winter 
•  Saturday December 25th --Christmas 
•  Friday December 31st --New Years Eve 

 
 
 
 
 
 



Region 4 – Are You Ready To THINK BIG?!? 

Have you been wondering what Region 4 will be doing as an incentive for its 
members to Think Big?  Well, wonder no more.   

Region 4 will have 3 drawings as follows: 

July (for March, April, May, and June) 

November (for July, August, September, and October) 

March (for November, December, January, and February) 

How do you get your name in a drawing and what can you win?? “Easy peasy 
lemon squeezy!”  All you need to do is sponsor a new member – any new 
member.  It can be a student member, associate member, or regular member.  
Every time you sponsor a new member, your name and the new member’s name 
will be placed into the corresponding drawing, depending upon their join date.  
Winners will receive a $25 Amazon gift card, plus a NALS goodie bag filled 
with NALS goodies.   

At the end of the year, we will draw a GRAND PRIZE WINNER from all the new 
members and their sponsors.  What is the Grand Prize?  Well, we’re going to 
keep that a secret for now, but one of the prizes will be a $100 Amazon gift 
card!!  

I have already sponsored one new member this year, which makes me eligible 
for the July drawing, as well as the year end drawing!  Two chances to win and 
all I had to do was tout the benefits of NALS to someone who was interested!   

PLUS… there is an added benefit!!  If you recruit 5 members (of like membership 
status) within the year, you can get your national dues waived!  Not only would you 
then have 6 chances to win prizes, but you would save $98!!  

If you have any questions, please don’t hesitate to contact me!  

Good luck Region 4!! 

Lisa 

____________________________ 
Lisa J. Mitchum, PLS 
2010-2011 NALS Region 4 Director 
Smiley Bishop & Porter LLP 
1050 Crown Pointe Parkway 
Suite 1250 
Atlanta, GA  30338 
lmitchum@sbpllplaw.com 

Direct Dial (770) 829-3847 
 

mailto:lmitchum@sbpllplaw.com
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What Have We Learned About You? 
By Jay Moore, NALS Communications Manager 

 

As many of you know, NALS...the association for legal professionals has put together a 

Think Tank of individuals to evaluate the association and the profession to ensure that 

the two are aligned in the most efficient way possible. As part of the process, NALS 

seeks to learn what you want from it and will adjust its programs so you are getting the 

most out of your membership. 

 

Recently, the NALS Think Tank surveyed 500 legal professionals online to gather 

information about their careers and involvement in professional associations. NALS is 

already using these findings to move forward by offering more CLE sessions included in 

your dues and increased CLE opportunities at the 2011 NALS Education Conference 

and National Forum. It is also focusing these additional CLE sessions on the areas of 

law in which you work. NALS will begin offering CLE tracks focused on the areas of law 

that were proven to be the most applicable to our membership and the industry. 

 

We were able to narrow the fields of law to four general areas, with additional sub-areas 

that are more specific. The idea is not to have a group for each and every area of law, 

as we would not be able to efficiently service each of those groups in a way that would 

be beneficial to you. Instead, the idea is to give the NALS Education Committee some 

guidance and focus on the legal areas in which many of you work. NALS’ programs will 

offer more specific and targeted education with a greater impact on your career. The 

broad areas of law that we will be focusing on are: Civil Litigation, Corporate Law, 

Estate Planning/Family Law, and General Practice. 

 

The results of our survey showed that nearly 40% of respondents worked in litigation, 

with another 20% working in civil law. By grouping the areas of law that fall under 

corporate focus, we are targeting another 34% of respondents. Estate planning and 

family law areas, which have been grouped together, made up another 51%. The 

remaining specialty areas of law were added to a general practice group, allowing NALS 

the flexibility to offer education in many other areas of interest. Note that in designing 

the survey, we were aware that many legal professionals work in more than one area of 

law and so we allowed respondents to select multiple responses. This is why the results 

total more than 100%. 

 



 

 

A resounding 82% of respondents told us they value a professional association’s 

relation to their profession and career. Approximately 60% responded that the number 

one thing they looked for in an association was overall education value. These 

overwhelming responses indicate to us that combining a greater education value with 

focused career-enhancing topics will result in a greater benefit from NALS membership 

dues. 

 

When surveying the job titles of the respondents, we learned that 53% were paralegals, 

23% were legal assistants, and 17% were legal secretaries. One area of concern was 

the 6% of respondents who are currently unemployed. NALS will continue to assist 

those that are unemployed through the NALS Career Center (careers.nals.org) and will 

continue to offer the dues waiver for those members who are unemployed at the time of 

their renewal. NALS understands the tough economic times and we will do everything 

that we can to assist our members who may be struggling. 
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We were happy to learn that nearly 35% of respondents have been in the legal field for 

more than 25 years, which shows how dedicated you are to your careers. We also 

learned that 60% volunteer for local or national charitable organizations, which tells us 

that you are interested in making a difference in your communities. NALS will continue 

to foster relationships with national charities to help provide you with opportunities to 

provide an impact on society. 

 



 

 

The NALS Think Tank will continue to monitor the industry and recommend areas of 
improvement for the association. If you have any recommendations, please send an 
email to thinktank@nals.org. We will review your message and see what we can do to 
investigate further ways we can better serve you. 
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 9-Member Contact Information 
 

In an effort to have up-to-date contact membership contact information, please omplete 
the following information and either email, mail or fax to Tonya Bowman: 
 
 
Full Name:     
 
 
Firm/Company Name:     
 
 
Address:     
 
 
  
 
 
Preferable Contact Number:     
 
 
Fax Number:     
 
 
Area of Practice:     
 
 
Birth Date (Month/Day) :     
 
 
Year joined NALS:     
 
 
Preferred Email Address:     
 
 

Send this form to: 
 

Tonya Bowman 
Craft & Sheppard, P.L.C. 

1604 Westgate Circle, Suite 1 
Brentwood, TN   37027 
Phone: (615) 309-1707 

Fax: (615) 309-1717 
tonyabowman@CraftSheppardlaw.com 

  

mailto:tonyabowman@CraftSheppardlaw.com


Did you know? 
The NALS Career Center is part of the Legal Job Exchange and partners with the 
American Bar Association, American Immigration Lawyers Association and the North 
Carolina Bar Association to make sure that your job listings and resumes are viewed 
across the network.  
That means that you can place an ad with NALS and have it seen by members of these 
organizations as well. This also means that if you are on the job hunt these 
organization's job listings will be found in the NALS Career Center. If you haven't 
checked it out have a look today...there are currently 11 jobs open in the legal 
support category.  

Reminders: 

 Register Today for the Professional Development & Education Conference!  

 Find out What is New at NALS Online...follow the blog! insideNALS will list all updates to posts on the NALS 
site.  

 Have you read the October issue of the NALS docket?  It is available and has some great articles.  

 
Upcoming Sessions from NALS:  

 
Online Learning Center: 

 December 1, 2010 - Current Trends in Regulation CLE  

 

WebEd Sessions: Don't forget to check out the past sessions you might have missed! Recordings are 
available.  

 December 16 - Team Building (Future Leaders Development - FREE TO MEMBERS!)  

 

THANK YOU!  THANK YOU!  THANK YOU! 
 
As always, our NALS members came through. With only three weeks to publicize and collect money for the 
Branson charity, Mountain Country Homes of Hope’s ReBuilding Hope Project, the members in attendance and 
chapter donations managed to raise ONE THOUSAND THREE HUNDRED TWENTY FIVE DOLLARS for the 
charity.  The Executive Director of the charity was absolutely thrilled with the results of our fund-raising efforts.  
Remember, if you made your donation by check, you can use that cancelled check for a receipt at tax time.  Mountain 
Country Homes of Hope is a 501(c)(3) non-profit and therefore tax deductible.  

 

Education 

Are you in need of CLE credits, but don’t want to miss out on the holiday season activities? There is an easy 
answer to your problem!  If you missed a webinar that you wanted to attend, or are in a crunch to get the last few 
credits for recertification, there is a great way to get the education you need on your schedule.  Accesses to past 
webinars are available for purchase in the NALS store.  To register for a webinar is easy.  Simply go to www.nals.org 
and under the ―Learn‖ tab, click WebEd.  Scroll down to see the schedule or click register now.  

The Future Leaders Development has some upcoming great Webinars that are FREE to members.   Their last 
session for 2010 will be on December 16, 2010 on the topic of Team Building.  Whether you are planning on being a 
future leader in NALS (or anywhere else), or just someone who wants to learn those valuable leadership skills, these 
sessions are perfect to expand your leadership horizons!  

http://careers.nals.org/
http://careers.nals.org/
http://www.nals.org/?page_id=99
http://www.nals.org/?page_id=21
http://www.nals.org/?page_id=85
http://www.nals.org/?page_id=47
http://www.nals.org/?page_id=45
http://www.nals.org/?page_id=1291
http://services.nals.org/portaltools/shopper/Index.cfm?RptCategPassed=web&RptCodePassed=Webinars
http://services.nals.org/portaltools/shopper/Index.cfm?RptCategPassed=web&RptCodePassed=Webinars
http://www.nals.org/?page_id=45
http://www.nals.org/?page_id=45
http://www.nals.org/?page_id=45
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Finally, the Online Study Groups for those of you who are preparing to take the ALS, PLS and PP exams in March of 
2011 will return in January.  

Membership 
RECRUITMENT IS AN ON-GOING ACTIVITY. ONE EFFECTIVE RECRUITMENT TECHNIQUE IS FOR MEMBERS TO 

ENCOURAGE YOUR FRIENDS TO BECOME INVOLVED IN NALS.  SOMETIMES WE TURN TO OUR CO-WORKERS WHEN 

TRYING TO RECRUIT NEW MEMBERS—FORGETTING ABOUT OUR FRIENDS WHO ALSO WORK IN THE LEGAL 

ENVIRONMENT.  ANOTHER TECHNIQUE IS TO OFFER AN INCENTIVE TO THOSE WHO RETAIN NEW MEMBERS.  TRY 

SPONSORING FUNCTIONS SUCH AS A DINNER OR OPEN HOUSE, WHICH DOUBLES AS A MEMBERSHIP DRIVE.  HAVING 

INTERESTING SPEAKERS AT MEETINGS IS AN ADDITIONAL WAY TO ATTRACT POTENTIAL MEMBERS. 

Make Visible Changes  

People are impressed with an association that works together and gets results.  Some members need to see visible 
results of what an association can do before they volunteer their time.  To motivate members, make it known your 
current projects or community service involvement.  

Let Them Know 

After a successful completion of a project, it is important to acknowledge those members who were instrumental in 
the process.  A special announcement at your meeting is a good way to acknowledge those members and it will keep 
the membership informed on an on-going basis of the project/completion.  Handing out ―Certificates of Appreciation‖ 
to those members is an extra acknowledgment.  Other members might even get inspired to participate.  

Be Responsive and Welcoming  

Motivate people by making them feel important.  Make sure all members feel welcome at meetings.  Encourage new 
members to participate and be responsive to their needs and suggestions.  The results may be evident in your 
membership renewals!  

Text Development 
 
Want to avoid any shocking events or being haunted by mistakes?  Don’t overlook the good information available in 
the Basic Manual for the Lawyer’s Assistant and the Advanced Manual for the Lawyer’s Assistant.  If you have a good 
basic understanding of your area of legal work, you can avoid being tricked in the workplace! 
 

NALS Foundation 

THANK YOU! 

Somehow, those two simple words don’t seem adequate to express the Foundation’s gratitude to our members.  
Through your support and amazing generosity, the NALS Foundation raised over $17,000 at the 2010 National 

Forum!  

At Saturday night’s gala, the Beartones, 14 young men from Missouri State, delighted the members in attendance by 
joining them for dinner and later entertaining them in song.  A mix of traditional and contemporary songs were 
transformed by this a cappella group and it left our members wanting more.  

Just how much fun was Branson?  Ask Brenda Simmons, a new Circle Donor, who just happened to be the recipient 
of a pink tourmaline necklace that was given away in a drawing held for Circle Donors.  Or, you could ask, Barbara Le 
Captain—the winner of an Ipod Nano; or Kathy Cusack—the winner of a Kindle or maybe even Debra Waters—the 
lucky recipient of the fire agate necklace that was showcased in Tulsa.  

http://www.nals.org/?page_id=59


During the 2009-10 fiscal year, the NALS Foundation awarded grants in excess of $24,000 and with your continued 
support we will make even greater strides in serving the members.  

The NALS Foundation Trustees THANK YOU!!  

More from the NALS Foundation 

The NALS Foundation, a 501(c)(3) nonprofit educational foundation working hand in hand with NALS…the 
association for legal professionals to enhance educational opportunities, was established in 1989.  

The NALS Foundation is governed by a volunteer board of trustees who have designated the following as funding 
priorities:  

 Educational/Research Opportunities  

 Grants  

 Keynote Speakers/Workshops  

 Jett Awards  

 Recognitions  

YOU—  

 want to be part of assisting our legal professionals  

 are motivated and dedicated to ―giving back‖  

 attend the NALS conferences (national forum and professional development)  

 are a Circle Donor  

 could be a NALS Foundation Trustee!  

If interested, contact Julie Abernathy  
julie.abernathy@haynesboone.com  
(512) 867-8409 (work)  
(512) 288-6219 (home)  
(512) 507-7982 (cell)  

 

 
 The NALS Think Tank needs your help! Fill out the Legal Support Industry 

Survey Today.  

 Need Help Getting Around the NEW NALS Website? Check out this post that will 
highlight the new features and help you navigate!  

 Follow along with everything NEW at NALS Online...visit insideNALS!  
 

Upcoming Sessions from NALS: 

Education 
Are you in need of CLE credits, but don’t want to miss out on the family activities of 
the summer? Well, there is an easy answer to your problem! If you’ve missed a 
webinar that you really wanted to attend, or you are in a crunch to get those last few 
credits you need for recertification, there is a great way to get the education you 
need on your schedule. Past webinars are available for purchase in the NALS store. 
Registering for a webinar is easy. Simply go to www.nals.org and under the “Learn” 
tab, click WebEd. Scroll down to see the schedule or click “Register Now”.  

http://www.nals.org/?p=134
http://www.nals.org/?p=806
http://www.nals.org/?p=136
http://www.nals.org/?p=797
mailto:julie.abernathy@haynesboone.com
http://www.surveymonkey.com/s/legalsupportsurvey
http://www.surveymonkey.com/s/legalsupportsurvey
http://www.nals.org/?p=922
http://www.nals.org/?p=922
http://www.nals.org/?page_id=21
http://www.nals.org/?page_id=45
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Mark your calendars now for these upcoming educational sessions in the OLC, OLSG 
and webinars (all sessions are at 8:00 p.m. Central): 
Online Learning Center (OLC) – FREE TO MEMBERS 
 
 
INSTRUCTIONS TO ACCESS WEBINARS: To register for a NALS Webinar, simply go to 
the NALS website and under “Learn” (tab with drop down choices at top of NALS web 
page), click on “WebEd.” This will take you to the screen to register for the webinar 
you wish to attend. There are “how to” directions on this page and descriptions of the 
webinars offered. You just need to scroll down and click on the registration link (the 
title of the webinar) and it will take you through the registration process. The 
webinar registration is a two-fold process. The initial registration lets you select 
the webinars you are interested in attending and submitting your payment 
information. When that information is processed, participants are sent a WebEd 
invitation that will complete the registration. When you have completed this 
second “invitation,” a subsequent e-mail is sent to the participants, which 
contains access information to the webinars. NOTE: You can access any webinar 
through both the Internet and the audio connection (with any telephone) OR you can 
simply access the webinar presentation (without viewing the PowerPoint 
presentation) by simply calling and connecting to the audio portion of the 
presentation. You can do this from any telephone anywhere! But you still need to 
register for the webinar (even if you will only be listening to the audio portion of the 
program). 
INSTRUCTIONS TO ACCESS OLC/OLSG: Members must first login as a Member and 
enter your login name and password. If you have not registered as a member just go 
to the “Welcome” tab at the top of the NALS web page (it’s a drop down tab with 
“Member Log In” – click there). There are complete instructions to login as a member 
or to register as a member to access all the membership services. After you login as a 
member you will see a page with member accessed information (on the left-side of 
the screen). Simply scroll down to Online Learning Center, click and you have now 
entered the OLC properly! The OLC page comes up with instructions, but you can 
simply scroll down and type in a "User Name" (user name does not have to match your 
Internet user name) and click "Connect," which will take you to the "Lobby." Click on 
the tab/icon at the top, right-hand side of OLC screen (it has what looks like a 
comment box on the tab), and then double click on "OnlineLearningCenter" and, voila, 
you're there! You can increase the size of the screen by clicking on the four arrows 
button (second button from the right at the bottom). You can increase the size of 
your font by clicking on "Options" (upper left, second button from left) then "Font 
Size." You can change the color of your responses by clicking on the colors button 
(third button at from the left at the bottom). Yes, we do have emotions and sounds 
which can be entered, but, particularly the sounds, can be distracting and our 
intention is to get you in, discuss the topic, and let you go within the allotted time. 
Also, you must participate every three to four minutes or you will be "bumped" out. 

 MESSAGE TO ALL MEMBERS OF NALS COMMUNITY 



Take part in our latest survey so that we can learn more about what your career is like and help us 
understand what you are looking for in a professional association.  
 

http://www.surveymonkey.com/s/legalsupportsurvey 

Visit NALS community at: http://nalsnet.ning.com/?xg_source=msg_mes_network 

 
 
 
 
 
 
 
 

When you join NALS, you have access to a wealth of information and affinity providers.  
Are you taking advantage of your ENTIRE membership in NALS? 
 

 
 
 
 

 
 
 
 
 

eNews – Are you receiving the bi-weekly newsletter of pertinent 
information about NALS?  If you are a member and want to receive 
the newsletter, please email Jay Moore at moore@nals.org. Until 
then, enjoy the most recent issue by going to the following link:  
 
http://www.nals.org/newsletters/enews/pastissues/en09.01.09.html 

 

Members have access to outside providers that brings many services 
that otherwise might be substantially more expensive to NALS 
Members. (www.nals.org/membership/benefits/affinity.html) 
I personally use Liberty Mutual.  NOW, Sam’s Club is part of NALS 
Affinity Provider.  

Members can take advantage of online professional development 
and legal education in the Online Learning Center for FREE in the 
comfort of your own home during the evenings.   

 
 

REMEMBER:  You do not have to be a certified member to enjoy these sessions.  
In today’s uncertainty with employment, it is great to stay educated and this is 
only one way to achieve a high level of education.   
 
TOPICS:   http://www.nals.org/onlinelearning/index.html 
 
Instructions on Entering Online Center: www.nals.org/onlinelearning/room 
 

 

Leading The Way - is the NALS Leadership Newsletter that is 
available to ALL members of NALS.  If you’re interested in staying in 
touch, go to:    (www.nals.org/newsletters/leadingtheway) 

http://www.linkedin.com/redirect?url=http%3A%2F%2Fwww%2Esurveymonkey%2Ecom%2Fs%2Flegalsupportsurvey&urlhash=HCj-
http://nalsnet.ning.com/?xg_source=msg_mes_network
http://www.nals.org/membership/benefits/affinity.html
http://www.nals.org/onlinelearning/index.html
http://www.nals.org/onlinelearning/room
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 WHAT IS NALS, ASSOCIATION OF LEGAL 
PROFESSIONALS, NASHVILLE CHAPTER? 

 
NALS, Association of Legal Professionals, 
Nashville Chapter (―Nashville Chapter‖) is a 
multi-level organization. Membership in the local 
chapter brings membership in TALS –Legal 
Professionals of Tennessee (―TALS‖), NALS 
Region 4 and NALS…the association for legal 
professionals (―NALS‖). 
 
The Nashville Chapter was first organized in 
1949 and was chartered with TALS and NALS in 
1972. 
 
WHAT IS TALS? 
 
TALS holds an annual convention and quarterly 
meetings throughout the state. In addition to the 
business meetings, legal education seminars 
are offered at these meetings. Each local 
chapter sends a Governor to report back to the 
chapter all business transacted; however, 
members are encouraged to attend. State 
meetings and seminars afford a wonderful 
opportunity for networking with other legal 
professionals from across the state that have the 
same goals and objectives. 
 
WHAT IS REGION 4? 
 
Region 4 is lead by an elected regional director 
that plans a meeting once  a year with the states 
that cover our region.  The states that are within 
our region is Alabama, Georgia, Florida, North 
Carolina, South Carolina, and Tennessee.   This 
meeting is not as large as the NALS national 
educational or professional development 
meetings; but, they are generally larger than the 
state meetings.  It is a wonderful way to meet 
other legal professionals that has the same 
goals and objectives as you do; but, closer to 
home. 
 
WHAT IS NALS? 
 
NALS is a non-partisan, non-profit, non-
sectarian corporation based upon principles of 
service to all areas of the legal field. 
Membership is open to all persons engaged in 
service in the legal forum, including, but not 
limited to, attorneys, legal assistants, paralegals, 
secretaries, typists, word processors, court 
clerks, clerks employed in law offices, persons 
employed by the courts, trust departments of 
banks or trust companies, and those persons 
employed in public or private institutions directly 
engaged in work of a legal nature.  

 
WHEN ARE MEETINGS HELD? 
 
Nashville Chapter Membership meetings are 
held on the third Monday of each month at Noon 
at the Nashville Bar Association.  A monthly 
Lunch & Learn is offered at a nominal cost by 
reservation on the second Wednesday  at the 
Tennessee Bar Association.   
 
WHEN ARE NASHVILLE CHAPTER’S LUNCH 
& LEARNS HELD? 
 
Nashville Chapter Lunch & Learns are held on 
the second Wednesday of each month at noon 
at the Tennessee Bar Association. Because of 
the venue, a box lunch is offered, and may 
change over the course of the year at a cost of 
$12 and is a reservation only meeting. The lunch 
hour is devoted almost in its entirety to a 
speaker advising on a legal or community topic. 
You do not have to be a member to attend. 
Attendance at the Lunch & Learn is a good way 
to find out more about the Nashville Chapter and 
meet its members.  
 
HOW MUCH DOES MEMBERSHIP COST?  
 
The annual fee for new members is $120.00. 
Thereafter, the annual renewal is $110.00. A 
portion of this amount pays your dues to TALS 
and NALS.  
 
WHAT DOES MEMBERSHIP OFFER ME?  
 
You will be a member of a professional 
organization dedicated to the furtherance of 
legal education and having as its main objective 
the encouragement of its members to attain a 
high degree of professional excellence in their 
chosen career.  
 
You will receive publications written for the legal 
professional, including The Verdict, our local 
monthly publication, The Junction, the TALS 
state quarterly publication, Region 4 Newsletter 
and @Law, the NALS national quarterly 
publication.  
 
You will have the opportunity to attend seminars, 
study groups, workshops, and other activities 
which will enhance your legal education 
relationships in a local and national network.  
 

 

 
 

 
 



You will have access to employment placement 
at no charge through the Employment 
Committee.  
 
You will be given the opportunity to serve on 
committees which function to promote the goals 
and objectives of the association and, in the 
process, allow a greater opportunity for new and 
lasting friendships among members.  
 
You will be eligible for discounted travel and 
rental car rates, group insurance programs, a 
retirement program, loan programs, and credit 
card applications.  
 
WHAT IS THE PROFESSIONAL PARALEGAL 
EXAM?  
 
The Professional Paralegal (PP) certification 
was developed by NALS to promote legal 
professionals who wish to be identified as 
exceptional in all areas of the law. Certain 
eligibility requirements must be met to take this 
exam, and are available for viewing at 
www.nals.org.  
 
WHAT IS THE PROFESSIONAL LEGAL 
SECRETARY PROGRAM?  
 
The Certified Professional Legal Secretary 
(PLS) designation is achieved by passing a 
rigorous one-day examination. Eligibility for the 
exam requires at least three (3) years’ 
experience as a legal secretary.  
 
The Accredited Legal Secretary (ALS) 
designation is achieved by passing a half-day 
examination and is available to persons who 
have completed one of the following: a 
secretarial course, the NALS Legal Training 
Course, or one year of secretarial experience.  
 
Those interested in sitting for these 
examinations can attend group study sessions 
held in advance of the examination. These 
sessions are provided without charge to 
members. The examinations are given at testing 
centers throughout the United States with one 
center being located in Nashville.  
 
The examination covers a variety of subjects: 
Written Communication; Ethics & Judgment; 

Office Procedures & Technology; Legal 
Knowledge & Skills.  
 
NASHVILLE CHAPTER ANNUAL EVENTS  
 
Bosses Appreciation Luncheon is held each 
October. This event affords the legal secretary 
the opportunity to invite the attorney for whom 
she works to a special lunch.  
 
The ―Chris Galyon Scholarship Award‖ is 
presented annually to a worthy individual who 
has exhibited a desire to further his or her 
education in the legal field.  
 
Legal Professionals Night Out is held each year 
for the legal community to come together on a 
social basis for the purpose of promoting NALS 
and encouraging membership in our 
Association.  
 
In 1972, the President of the United States 
proclaimed Court Observance Week an annual 
event in October. Each year our members 
sponsor a program to recognize our judicial 
system.  
 
NASHVILLE CHAPTER NOTEWORTHY 
ACCOMPLISHMENTS  
 
The Nashville Chapter hosted the Annual 
Meeting and Educational Conference of the 
National Association of Legal Secretaries 
International in July 1985 with approximately 
1,000 members, delegates, and their families in 
attendance.  
 
The Nashville Chapter has the proud distinction 
of having members Chris Galyon, PLS elected 
National President for 1984-85 and Tina L. 
Boone, PLS elected as Region 4 Director from 
2005-2007. Other members have been or 
currently serve as officers, committee members 
and chairmen at both state and national levels.  
 
HOW DO I BECOME A MEMBER OF THE 
NASHVILLE CHAPTER?  
 
Contact any member or:  
 
Tonya Bowman, Membership Director 
Craft & Sheppard, P.L.C. 
1604 Westgate Circle, Suite 1 

http://www.nals.org/
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FREQUENTLY ASKED QUESTIONS  
 
WHAT ARE THE QUALIFICATIONS FOR 
MEMBERSHIP?  
 
Individual members consist of those persons 
engaged in work of a legal nature and who 
agree to comply with the NALS Code of Ethics 
and Professional Responsibility.  
 
HOW DO I BECOME A MEMBER?  
 
You can use the secure online application, or 
you may choose to print out the application right 
from the web site or in Adobe PDF format and 
mail or fax it. Simply choose the method you 
want to apply, fill out the NALS Membership 
Application, select a method of payment, and 
submit your application. You then just sit back 
and will receive your new member package from 
the NALS Resource Center within four weeks.  
 
Categories of membership:  
 

Regular Member  
International Member  
Retired Member  
National Associate Member  
    (educators, judges and attorneys)  
National Student Member  
    (must be a fulltime student)  

 
WHY SHOULD I JOIN NALS?  
 
Opportunities for professional and personal 
development are plenty when you join NALS. 
NALS is a tri-level organization composed of 
NALS, your state association, and your local 
chapter. Each offers topnotch professional 
growth through seminars, quality publications, 
and local, state, regional and national 
networking. NALS offers several regional and 
national conferences each year packed with 
outstanding education and featuring excellent 
speakers from around the country. State and 
local chapters offer more frequent meetings to 
give in-depth local educational coverage.  

 
Additionally, NALS supports its members by 
providing the following benefits:  
 
Affinity Programs - members enjoy discounts on 
a variety of goods and services.  
 
Certification - accreditation for everyone, 
whether beginning a new career or enhancing 
your current one.  
 
ALS--the basic certification for legal 
professionals, PLS--the advanced certification 
for legal professionals and Professional 
Paralegal certification.  
 
@Law Magazine - members receive this award-
winning publication quarterly.  
 
E-Learn - a monthly update on current topics of 
interest to legal support staff, delivered via e-
mail.  
 
E-News - a bi-weekly electronic newsletter sent 
to all NALS members who provide an email 
address, which includes timely information and 
details of NALS activities, with links to 
educational information and topics of interest to 
legal support staff.  
 
NALS Online Learning Center - Education and 
personal development offered on a variety of 
subjects with the added bonus of networking 
across the United States.  
 
NALS also presents a host of other professional 
development programs including the Legal 
Training Course, NALS Educational Institute, 
and college credits.  
 
WHAT IS E-LEARN AND HOW DO I 
SUBSCRIBE?  
 
E-learn is a monthly educational subscription 
received by NALS members via e-mail or fax 
featuring articles, technology tips, legal 
community news, etc. If you are currently a 
member and not receiving e-learn and would like 
to be on the distribution list, please contact 
Saundra Bates, NALS Member Services 
Manager at bates@nals.org or 918-582-5188. 
Saundra will be happy to add you to our list.  
 

mailto:tonyabowman@CraftSheppardlaw.com


WHAT ARE THE BENEFITS OF THE NALS 
ONLINE LEARNING CENTER?  
 
Education, updated information on NALS and 
various legal topics, networking across the 
country are just a few of the benefits afforded 
our members who make it a point to participate 
in our weekly Tuesday and Wednesday night 
NALS Online Learning Center sessions. Each 
week a different topic is chosen as an 
educational subject or for discussion over the 
Internet lines. Come check us out!  
 
WHO DO I CONTACT WITH REGARD TO 
MEMBERSHIP QUESTIONS?  
 
Saundra Bates, NALS Membership Services 
Manager or Tonya Bowman, NALS, Nashville 
Chapter Membership Director  
 
WHAT DO THE FOLLOWING ACRONYMS 
MEAN?  
 
ALS . . . the basic certification for legal 
professionals: The ALS designation is an 
attainable goal for someone entering the legal 
support field. Demonstrate your acceptance of 
the challenge while improving your onthe- job 
skills in the areas of communication, accounting, 
office administration, ethics and legal 
procedures.  
 
PLS . . . the advanced certification for legal 
professionals: The certified PLS designation is 
the best way to show off your expertise in areas 
including legal terminology and procedures, 
ethics, office procedures, and communication 
skills. That could mean more money and more 
opportunities for you, or it could mean doing a 
better job for your present employer! The PLS 
certification is recommended by the American 
Council on Education (―ACE‖) as valuable 
college credit for as much as 27 semester hours.  
 
PP: Professional Paralegal, this is the newest of 
the NALS Certifications  
 
SMC: State Membership Chairman  
 
LMC: Local Membership Chairman  
 
CLE: Continuing Legal Education  
 

CLA: Certified Legal Assistant  
 
@Law: The Official NALS Magazine. As a 
member of NALS . . . the association for legal 
professionals, you will receive @LAW four times 
a year. Each issue features informative articles 
and time-saving resources. @LAW is so 
informative it won the coveted Gold Circle Award 
for Most Improved Magazine from the ASAE. 
The @LAW subscription rate for nonmembers of 
NALS is $40.00 per year.  
 



 

 
 

                    
 
Call Jane e Dillon                      Village Real Estate  
615-668-9565                          2206 21st Ave S 
Accredited Buyers Representative               Nashville TN 37212 
Graduate Realtor® Institute                         383-6964 
Certification for Internet Professionalism   
 

“My business is built on your Referrals”   

If you have friend or family member looking to buy or sell,  I would love to help!                                              
Providing Solutions with You in Mind!



 

  

Providing Solutions with You in Mind!

Many Companies can offer one or 

the other of these two services.  

B2L offers both!

Serving the Entire Middle Tennessee Region!

Call Today to get a 
FREE Quote on a 
Home Inspection or 
Land Survey!

Contact Information: 
 

1198 Old Pinnacle Rd. 
Joelton, TN 37080 

Phone: (615) 430-4490 
Email: b2lhps@gmail.com 

Visit our  

website! 

www.b2lhps.com 

Land Surveying and Home Inspections

Home and Property Solutions 

“B2L understands that “time is of the essence” when it 
comes to the real estate closing process.  B2L will work with all 
parties involved to ensure that our services are provided in a 
timely manner.  Trust B2L with all your land surveying and 

home inspection needs.” 
 



 

 

 

ABS Tax and Accounting Service 
     4811 Lebanon Rd., Suite 102 
     Hermitage, TN  37076 
     Phone: (615)  883-8828 
             Fax:  (615) 883-6520 
            E-mail:  absfinancial@comcast.net 
 
 
 

(YOUR AD HERE) 
Become an advertiser with The Verdict.  Please contact 
vhellmer@lewisking.com for more information. 

mailto:absfinancial@comcast.net
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